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Introductie
Welkom bij de SOFv-InDesign workshop! De 
workshop bestaat uit twee delen, een A- en 
een B-deel. Ik zal eerst even wat vertellen over 
InDesign, en dan uitleggen wat er behandeld 
wordt in de beide gedeeltes.

Over InDesign
InDesign is een programma van Adobe, de 
makers van ook onder andere het welbeken-
de ‘Photoshop’ en ‘Illustrator’. Dit zijn de drie 
Adobe programma’s die je voornamelijk nodig 
zult hebben bij het maken van je visuele mate-
riaal. Ze zijn vrij gelijkend; ze hebben ook alle-
maal dezelfde lay-out. Fun fact: op de meeste 
uni-computers staan ze alle drie al geïnstal-
leerd! Het zelf aanschaffen ervan is namelijk 
vrij duur.
De meeste simpele bewerkingen kun je in alle 
drie de programma’s eigenlijk wel uitvoeren: 
zo kan je in elk van de drie wel een tekstvak-
je maken en met plaatjes slepen. Maar als je 
echt de diepte in wil, dan zul je toch echt een 
keuze moeten maken. Hieronder zet ik kort uit-
een wanneer je voor InDesign moet kiezen, en 
wanneer je wellicht moet denken aan een an-
der programma.

Wanneer Photoshop?
Photoshop is op z’n sterkst bij het maken van 
de zwaardere grafische bewerkingen, voorna-
melijk aan al bestaande foto’s. Dit programma 
heeft dan ook het grootste scala aan effecten, 
filters en andere bewerkingsopties.

Wanneer Illustrator?
Illustrator is het programma wat je van deze 
drie eigenlijk het minst nodig zult hebben. Hierin 
maak je voornamelijk ‘tekeningen’; denk hierbij 
aan logo’s of je eigen lettertype. Eigenlijk alles 
wat met ‘vectoren’ te maken heeft, komt hier in 
terug. Geen zorgen als je niet weet wat dat zijn.

Wanneer InDesign?
Nou, hier zijn we dan. Waarom zou je ooit In-
Design nodig hebben? Dat vroeg ik mezelf ook 
ooit af. InDesign is verreweg het handigste pro-

gramma als het gaat om het maken van consi-
stente bestanden waar je veel werkt met tekst. 
Hier moet je denken aan o.a. (jaar-)boeken, for-
mulieren en nieuwsbrieven. Ook de RAGweek 
kalender wordt elk jaar gemaakt in InDesign! 
Kort gezegd, als je op elke pagina ongeveer 
dezelfde opmaak wilt met slechts een andere 
invulling, dan is InDesign je beste vriend.

Gedeelte A
Het A-gedeelte van de workshop is voor de ech-
te beginners, mensen zonder enige ervaring in 
InDesign. Hierin leer je o.a. de volgende dingen:
•	 Je weg vinden in InDesign;
•	 Alles over werken met tekst en tekstvakken;
•	 Alles over werken met afbeeldingen;
•	 De basis van Mastersheets;
•	 De basis over lagen
•	 Werken met figuren
•	 Basis over exporteren

Gedeelte B
Het B-gedeelte, zoals je wel hebt geraden, gaat 
voornamelijk over de iets gevorderdere zaken. 
Hier worden de volgende dingen behandeld:
•	 Geavanceerdere tekst opties
•	 Groepen
•	 Meer over Mastersheets
•	 Interactieve PDF’s
•	 Adobe Integratie
•	 Exporteren, printen, etc. voor gevorderden

Ik heb tijdens de workshop nog even gekeken 
wat de veelgestelde vragen waren, en heb de 
onderwerpen waar de meesten nog moeite mee 
hadden even verder toegelicht. Ook zijn hope-
lijk alle spelfouten er uit!

Voel je vrij om dit werkboekje binnen je vereni-
ging te verspreiden. Echter zou ik het wel fijn 
vinden als dit niet ergens openbaar op het inter-
net beland, dat is alles. 

Ik hoop dat je er veel van zult leren!
Succes,
Jorrit

Gedeelte A
Je weg vinden in InDesign
Voor we beginnen, is het wel zo handig dat je een beetje weet waar je alles kan vinden. In dit 
gedeelte doe ik mijn best zo helder mogelijk uit te leggen wat de meeste knoppen nou precies 
doen, of waar je in ieder geval moet zoeken als je een bepaalde soort bewerking wilt doen.

Maak met “Control + N” even een nieuw document aan. Selecteer bovenaan het scherm “Print” 
en dan in het menu A5, en selecteer rechts “milimeters” bij “units”. Klik vervolgens op “create”.
Hierboven zie je hoe mijn scherm er uit ziet, met wat getekende lijnen die ik zo uit ga leggen. 
Voor ik met mijn uitleg verder ga, doe even het volgende: ga bovenin je scherm naar “Window -> 
Workspace -> Reset Essentials”. Als je niet op een computer zit van de RU, kijk ook even of je wel 
de “Creative Cloud” (CC) versie hebt, in plaats van bijvoorbeeld CS5 of iets dergelijks, daar kan 
ook nog wel eens verschil in zitten. Druk ook even op “Control + Alt + H” om de weergavekwaliteit 
op maximaal te gooien.

Rood
Helemaal links in het rood zie je de belangrijkste knoppen, dat zijn je ‘tools’, ofwel gereedschappen. 
Deze hebben allemaal een icoontje, naam en een ‘shortcut’/sneltoets. De selectie-tool, de 
bovenste, kan je selecteren door er op te klikken of op ‘V’ te drukken. Hiermee kan je dingen 
rondslepen en aanpassen van grootte, en nog veel meer. Deze zul je het vaakst gebruiken.

Naast de selection tool zul je in de rest van de workshop nog veel gebruik gaan maken van de 
text tool, en de shape tool. Als je deze gereedschappen goed kunt gebruiken, kan je eigenlijk al 
hele mooie en professionele dingen maken. De rest van de tools kunnen je werk wat makkelijker 
maken, maar in deze workshop bespreek ik alleen deze drie. Ik adviseer je wel om na de workshop, 
als je de basis onder de knie hebt, eens te kijken wat je precies met elke knop kan doen. Mocht 
je dan ooit iets specifiekers in gedachten hebben, kan je het wellicht hiermee al gedaan krijgen.
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De text tool is te herkennen aan de grote T: ook gelijk de sneltoets waarmee je hem kan activeren. 
Hiermee kan je tekstvakken creëren en ze bewerken. Een erg belangrijk gereedschapje dus; in 
het volgende onderdeel zal ik er dan ook extra diep op ingaan.
Daarna hebben we nog de shape tool. Hiermee kan je allerlei vormen invoegen, zoals vierkanten 
en cirkels. Erg handig om je ontwerp wat meer stijl te geven en wat interessanter om naar te kijken 
te maken. Hier zal straks ook een deel van de workshop over gaan, dus maak je borst maar nat.
Voor de rest zie je hier onderop nog iets over kleuren. Je hebt altijd twee kleuren in je “tijdelijke pallet”. 
Een 1e kleur die je geselecteerd hebt (momenteel leeg, te herkennen aan de witte achtergrond 
met rode streep) en de 2e kleur (zwart). Als je hierop dubbelklikt kan je de kleur aanpassen. 
Mocht je ooit iets snel van kleur willen voorzien, kan je een van je twee voorgeselecteerde kleuren 
gebruiken om het allemaal iets te versnellen. Straks gaan we nog meer met kleuren werken, dus 
geen zorgen als je het nu even te snel vindt gaan.

Geel
Het gele is je werkblad. Hierop zie je het A4’tje wat je hebt aangemaakt, en boven en onder wat 
‘linealen’. Hierop kun je later in de workshop je hulplijnen baseren. 
Daarnaast zie je ook nog een paars vierkant: dit zijn je marges. Op het moment heb je vermoedelijk 
de standaard marges aan staan: helemaal prima. Als je al je belangrijke inhoud hier binnen houdt 
(tekst, en bij foto’s de belangrijkste elementen), dan zit dit nooit te ongemakkelijk dichtbij de rand 
of in de vouw van je tijdschrift, om zo maar even wat te noemen. Dus, in het kort: zorg dat je 
belangrijke informatie altijd binnen de paarse randen valt. 
Bovenaan heb je nog wat tabjes: mocht je meerdere projecten open hebben staan kan je hier 
altijd naar toe wisselen door er simpelweg op te klikken.
Als laatste, nog een leuke tip: als je in InDesign werkt heb je altijd allerlei randen om je objecten 
heen die ervoor zorgen dat je ze eventueel snel kan bewerken. Mocht je graag willen weten hoe 
je document er geprint (= zonder al die randen) uit zou zien, kan je op ‘W’ drukken; nu ga je naar 
de preview mode. Je zult zien dat dan ook de paarse lijnen van je blad verdwijnen. Om terug te 
gaan druk je nogmaals op die toets. 

Groen
Helemaal rechts heb je ook iets staan, bij mij even omlijnd met groen. Het spreekt eigenlijk allemaal 
best wel voor zich, maar ik zal nog even kort uitleggen wat er allemaal mee bedoeld wordt.
Als je op pages klikt, zul je zien dat er een soort globaal overzicht ontstaat van je huidige pagina’s. 
Je hebt er nu 1, maar zodra je een groot document hebt kan je hier makkelijk pagina’s aanmaken, 
ze verslepen of allerlei andere interessante bewerkingen doen. 
Daarnaast zie je een knop layers, die is soms zelfs zo nuttig dat ik er ook een apart stukje voor 
de workshop voor heb vrijgehouden. Wat wel handig is om te weten is hoe lagen precies werken. 
Zie daarvoor dit geestige plaatje wat ik zojuist heb gemaakt. Aan de linkerkant zie je de lagen, aan 
de rechterkant zie je het resultaat. Stel je voor dat je van bovenaf kijkt, waardoor je laag 1 eerst 

ziet, en dan laag 5 als laatste. Doordat laag 3 zo is gemaakt dat hij zich ‘verstopt’ onder lagen 1 
en 2, zie je hem niet op het resultaat. Daarnaast bekleed laag 5 het hele front, terwijl je maar een 
klein stukje ervan ziet: dat is dus omdat de rest er al overheen zit. De bovenste laag zie je altijd 
als eerste, en de onderste als laatste. 

Verder over dat menuutje; links zijn als het ware je verwijzingen naar dingen buiten je InDesign 
bestand. Mocht je ooit een plaatje invoegen vanuit een andere map, dan moet InDesign kunnen 
onthouden waar die precies staat. Als je geen van beiden ooit verplaatst gaat alles goed, maar 
mocht je ooit of de InDesign file of je plaatje van locatie veranderen op je PC (in een andere map 
doen bijvoorbeeld, of verwijderen), dan begint InDesign te zeuren dat er een link missing is. De 
andere drie knoppen zijn dingen die met kleuren en opvullingen te maken hebben, daar gaan we 
ook bij de vormen op in.

Blauw
Zoals in elk ander programma heb je bovenin dit menuutje. Waar nu 78% staat, is hoe ver je het 
document hebt ingezoomd. Verder spreekt alles wel redelijk voor zich, maar het is belangrijk niet 
te vergeten dat dit ook nog bestaat.

Oranje
Als laatste hebben we dit onderdeel van je scherm. Dit geeft allerlei eigenschappen en instellingen 
weer van het object waar je mee bezig bent. Mocht je de selection tool hebben geselecteerd, dan 
zal deze balk lijken op wat ik er heb staan. Echter, wanneer je bijvoorbeeld tekstbewerkingen 
doet, zal deze gevuld zijn met allerlei handige knoppen voor tekstbewerkingen, enzovoorts. Meer 
ga ik er niet op in, het zal zich vanzelf wijzen. Hoop ik. Vraag het anders vooral even!

De Basis van Tekst
Dan gaan we nu eindelijk doen waar we voor gekomen zijn: beginnen met het leren van de basis 
van InDesign. We beginnen bij het maken van een tekstvak. Zorg dat je de text tool, waar je net 
over geleerd hebt, geselecteerd hebt. Ga vervolgens met je muis ergens op je werkblad staan. 
Klik een keer, hou je muis ingedrukt en beweeg vervolgens naar een andere plek op je scherm 
om een rechthoek te tekenen. Als je tevreden bent met de grootte van je veld, kan je je muis weer 

loslaten. Vervolgens kan je dubbelklikken op je tekstveld om er in te gaan typen.
Je tekst ziet er nu vermoedelijk nog heel saai uit. Je gebruikt waarschijnlijk een standaard lettertype 
op een standaard grootte. Dit kun je links-bovenin je scherm helemaal aanpassen, op die ene balk 
waar we het net over hadden die bij elk gereedschap allerlei specificaties in kan stellen. Selecteer 
je tekst maar en kies vervolgens een leuk font uit. Onder het font kan je zelfs nog, afhankelijk van 
of het bij dit font bestaat, nog kiezen of je bijvoorbeeld in het bold of italic wil schrijven. Ook kan 
je de grootte van je font er rechts van aanpassen. Zie het plaatje voor meer uitleg.

Het is natuurlijk erg veel moeite om telkens bij elk stukje tekst dat je een andere opmaak wil geven, 
telkens dit allemaal handmatig te gaan zitten aanpassen. Daarnaast zul je vast wel een bepaalde 
stijl in gedachten hebben die je bijvoorbeeld op elk kopje of elke hoofdtekst wil toepassen. In word 
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kan je dan altijd makkelijk “Kop 1” of “standaard tekst” aanklikken, om van die alvast gedefinieerde 
stijlen toe te passen. Zo makkelijk kom je er hier niet van af: je moet ze namelijk eerst zelf maken.

Zo’n eigen stijl heet een Character style.  Je klikt, zoals de afbeelding hieronder al suggereert, op 
de A en vervolgens op “New Character Style…”.

Ga vervolgens in het menuutje 
naar basic character formats, 
en selecteer bij font family je 
favoriete font, en bij font style je 
stijl. Daarnaast kan je ook nog 
de grootte veranderen. Vergeet 
niet bovenaan nog even de style 
name aan te passen, om je stijl 
een zinvolle naam te geven.
Vervolgens kan je op “OK” klikken 
om je nieuwe stijl te bevestigen. 
Als je nu je tekst selecteert en 
op het pijltje naar beneden klikt, 
zoals hier beneden op het plaatje 
aangegeven, dan kan je als het 
goed is je stijl selecteren en 
toepassen op je geselecteerde 
tekst. Zoals je ziet is mijn tekst nu 
Arial Black, size 24. Fun fact: dit 
is ook het lettertype dat Kakhiel 
gebruikt. Mocht je je straks nog 
vervelen, kan je altijd nog je eigen 
kakhiels in elkaar gaan schuiven.

Maak nog maar even zo’n stijl 
aan, maar dan voor je hoofdtekst. 
Wat vaak nog wel eens onhandig 
kan zijn bij ontwerpen, is dat 
je een hele boel mooie ideeën 
hebt, maar nog geen tekst om 
te bewerken. Ooit heeft iemand 
daar iets heel slims op bedacht: 
een generator die een Latijnse 
tekst genereert. De tekst zelf 
heeft geen inhoud, maar 
gebruikt wel veel soorten letters, 
lengtes van woorden etc, om 
het maken van opmaken toch 
wat chiller te maken. Op deze 
website kun je een stuk tekst 
genereren: https://nl.lipsum.com/. 
Klik ongeveer halverwege op de 
site op “genereer” en kopieer 
vervolgens de tekst even met 

“control+c”. Zet vervolgens de tekst even neer onder je kopje, zoals dit:

Zorg er wel even voor dat het je “Body” character 
style heeft. Wat je hopelijk zult hebben, tenzij 
je echt een asociaal groot tekstvak hebt 
aangemaakt net, is dat je tekst niet past in je 
huidige tekstvak. 
Je kan dan twee dingen doen: je kan of je vak 
groter maken (door aan de randen om je vak 
heen te trekken), of nog iets veel leukers. Je 
kan ook een nieuw tekstvak aanmaken, en er 
voor zorgen dat de tekst doorloopt. 

Dat laatste kun je doen door op het rode kruisje 
te klikken rechtsonderaan je tekstvak (deze 
geeft dus aan dat niet alle tekst in je vlak paste),, 
en vervolgens weer een nieuw vak tekenen 
zoals je gewend bent. 
Probeer dit hier rechts maar eens na te maken. 
Met wat slepen met vakken en een aantal keer 
op dat plusje klikken moet je er al zijn. 
Het mooie hiervan is dat als je nu ergens opeens 
nog wat tekst toevoegt, de tekst altijd door zal 
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springen naar het volgende vak. Mocht je dus met kolommen of meerdere pagina’s werken, dan 
kan je toch dezelfde lap tekst blijven bewerken. 
Daarnaast kun je ook opmerken dat InDesign zelf een woord af kan knippen met een ‘-‘: ze 
weten namelijk precies hoe lettergrepen werken en waar ze dan moeten knippen (in het Engels 
tenminste...). Zo hoef je nooit meer zelf na te denken! Dit wordt extra goed geïllustreerd als je 
ervoor zorgt dat de tekst ook aan de rechterkant de randen van je tekstvak volgt. Op de afbeelding 
hieronder staat hoe je dat moet doen.
Daarna nog iets korts wat misschien ooit relevant is voor je: soms zijn enters/witregels net iets 

te groot of te klein. In InDesign kan je, om dat probleem te verhelpen, ook zelf je regelafstand 
aanpassen. Hieronder een illustratie van hoe dat te werk gaat: hier zie je de getallen 1 tot en met 
3, die allemaal een andere ruimte tussen tekst aanwijzen. 

1 wijst naar een plek waar geen witregel is
2 wijs naar een plek waar er met behulp van de omcirkelde knop rechtsboven wat extra pixels 
aan witruimte is gemaakt. Dit kan je heel precies instellen, en kan zomaar eens van pas komen.
3 wijst naar een plek waar een witregel is gelaten

Dan weer even terug naar Character Styles, voor de laatste keer. Had ik al verteld dat als je een 
stijl aanpast, dat dan alle onderdelen waarop die stijl is toegepast in je document ook automatisch 
veranderen? Zo kan je makkelijk experimenteren met lettertypes en dergelijken. 

Daarbovenop kan je ook een nieuwe stijl aanmaken, en zeggen dat die is ‘gebaseerd op’ een 
andere stijl. Dat betekent dat deze nieuwe stijl alle eigenschappen van de geselecteerde stijl over 
zal nemen, behalve daar waar je het anders definieert. Dat is super handig voor als je bijvoorbeeld 
met subkopjes wilt werken: je wilt vaak graag dat dat hetzelfde lettertype is als je body, maar dan 
bijvoorbeeld net iets groter of in het bold. Dit kan je zoals hieronder geïllustreerd aangeven.

Lukt het jou om onderstaand plaatje 
na te maken? 

Tip: je kan bullet-points aanmaken door 
helemaal rechts in je tekst-instellingen 
balk op de bullet-point knop te klikken. 
Deze ziet er hetzelfde uit als in bijna 
alle andere programma’s, zo ook onze 
oude bekende microsoft word.
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Dan nog een laatste geinigheidje, voor we doorgaan naar het volgende onderdeel. Soms kom 
je te werken met tekstvariabelen. Dat zijn woorden/zinnen die een veranderen afhankelijk van je 
document. Denk hierbij bijvoorbeeld aan paginanummers: die zijn op elke pagina anders, maar 
je wilt wel dat hij het goede nummer aangeeft. Hiervoor is er ook al een knop: Neem gerust een 
kijkje tussen alle dingen die je kan invoegen, er zitten best wat toffe dingen bij.

Werken met Afbeeldingen
Dan gaan we nu eindelijk het document wat 
leuker maken: we gaan met plaatjes werken.  
Maak eerst maar even een nieuwe lege pagina 
aan, dan kunnen we die lekker gaan versieren. 
Een pagina toevoegen doe je zoals rechts 
aangegeven. Doe dat twee keer.

Daarna kan je lekker naar beneden scrollen 
op je werkblad, en dan zie je dat er gewoon 2 
nieuwe pagina’s zijn bij gekomen. 

Wat op zal vallen is dat deze twee naast elkaar 
staan, terwijl we er net maar 1 hadden. Dat komt 
omdat dat ons “voorblad” was; een tijdschrift 
heeft ook maar 1 voorpagina, en vervolgens 
als je hem open slaat zie je er 2. Op het einde 
moet je er dus wéér 1 losse pagina hebben als 
“achterblad”. 

In het workshop mapje zit ook een mapje met afbeeldingen die ik in een kinderachtige bui heb 
geselecteerd. Om een plaatje in te voegen kan je hem simpelweg in InDesign slepen: 

Vervolgens zul je, als je InDesign weer geopend hebt, zien dat je muis er iets anders uit ziet. 
InDesign wacht nu op jou die een rechthoek tekent waar het plaatje vervolgens in valt. 

Ik heb onze grote vriend Mark Rutte toegevoegd, en dat ziet er als volgt uit. Merk op dat de balk 
bovenaan weer andere eigenschappen laat zien, omdat we nu een plaatje geselecteerd hebben!
Dan komen we nu bij een wat minder intuïtief aspect van InDesign. Bij het werken met plaatjes 
zijn er namelijk twee dingen van belang. Als eerste heb je een kader, als het ware een fotolijst, die 
vaststaat in je document. Daarnaast heb je een afbeelding die je in dat kader zet. Deze twee kun 
je los van elkaar bewegen en aanpassen van grootte. Het kan echter in het begin nogal lastig zijn 
om nou te weten wanneer je welke aan het aanpassen bent.

Wanneer de randen om je object heen blauw zijn, dan ben je het kader aan het aanpassen. 
Probeer maar: zodra je de randen versleept dan merk je dat Mark niet meekrimpt, waar dat in 
word wel vaak het geval is. 
Als je dubbelklikt op Mark, zul je zien dat de randen oranje worden, zoals op de volgende pagina 
wordt geillustreerd. 
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Nu weten we dat we uitsluitend de foto van 
Mark aan het verslepen zijn, en niet het kader. 
Het kader zal gewoon op dezelfde plek blijven 
staan, terwijl je de foto van Mark nu zo groot of 
klein kan maken als je zelf wilt. Het werkt net 
zoals met een fotolijstje: je hoeft een kader niet 
helemaal tot de rand te vullen, maar je kan hem 
nooit tot over de rand vullen. 

Links onderaan deze pagina zie je daar een 
voorbeeld van. Zet onze vriend verder maar 
nog even terug voor de volgende stappen.

Maak vervolgens een tekstvak onder Mark aan, waarin je een onderschrift geeft voor bij de foto. 
Bij het verslepen van een element in de aanwezigheid van andere elementen zul je merken dat er 
allerlei groene lijnen zullen verschijnen. Dit zorgt er voor dat je bijvoorbeeld de randen op precies 
dezelfde breedte of hoogte kan plaatsen, wat super handig is voor een mooi en strak ontwerp. 

Nu je weet hoe je plaatjes aan moet maken, is het aan jou om onderstaand voorbeeld over te 
nemen om even extra goed te oefenen. Voor wat tips, zie de volgende pagina. 

Mocht je het ooit nodig hebben; je kunt de 
randen van een kader ook ronder maken. Dit 
kan zowel met tekst als met een plaatje. Als je 
het kader hebt geselecteerd zie je bovenin een 
gele knop. Klik daar maar eens op. Vervolgens 
verschijnen er op elke hoek allemaal gele ruiten: 
deze kun je verschuiven naar een bepaalde 
kant om een rand ronder te maken. Hieronder 
staat uitgetekend hoe dat moet, mocht de uitleg 
niet helemaal duidelijk zijn.
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Tip: als je een plaatje (of een ander object) wilt draaien, ga dan met je selection tool bij een van 
de hoeken staan en zorg dat je een soort draai-achtig pijltje te zien krijgt: als je dan klikt, ingedrukt 
houdt en je muis beweegt kun je iets draaien.

Tip: als je shift ingedrukt houdt tijdens het slepen, draaien of wat dan ook, zul je zien dat de com-
puter met je mee gaat denken. Bij het slepen zal de afbeelding op een horizontale, diagonale of 
verticale lijn blijven van waar hij al was, bij het draaien zal hij uitsluitend mooie afgeronde hoeken 
maken (zoals 90 graden), en bij het vergroten of verkleinen zal hij de verhouding tussen lengte en 
breedte hetzelfde houden. Wat kunnen computers toch veel.

Tip: soms wil je je tekst, zoals bij het onderschrift van de Mark close-up niet 
vanaf bovenaan je vak laten beginnen, maar vanaf onderaf of vanuit het mid-
den. Als je je met de selection tool het tekstvak geselecteerd hebt (en dus niet 
de tekst aan het bewerken bent maar het vak zelf) dan zul je bovenaan je balk 
zoiets tegenkomen. De optie linksonder zorgt er voor dat het midden van je tekst 
in het midden van het vak staat!

Daarnaast heeft InDesign nog allerlei speciale effecten die je toe kan passen op vakken, zowel 
tekstvakken als afbeeldingskaders. Als je met je rechtermuisknop klikt op het kader, kan je bijvo-
orbeeld een schaduw invoegen. Hieronder zie je hoe.

Mocht je tijdens het bewerken enigszins willen doorhebben wat je allemaal doet, kan je linksonder 
op “preview” klikken: dan verandert er in het bestand direct wat je allemaal aan het schuvien bent. 
Ik ga niet uitleggen wat hier allemaal staat, maar de dingen die je vooral aan wilt passen zijn je 
opacity,  je distance, je size en je spread. Probeer vooral even uit wat deze opties allemaal doen.

Mastersheets
Dan gaan we nu naar een abstracter concept: Master-
sheets. Stel je voor dat je bijvoorbeeld op elke pagi-
na dezelfde set aan hulplijnen wilt, op elke pagina een 
paginanummer op dezelfde plek en misschien nog wel 
een achtergrondje… wat dan? 
Onze helden van Adobe hebben daarop iets heel slims 
bedacht: Mastersheets. Zoals we net stijlen hadden 
voor teksten, zijn dit als het ware stijlen voor pagina’s. 
Je zet hier het liefst zo min mogelijk specifieke inhoud 
op, maar juist allemaal dingen die voor elke pagina het-
zelfde zijn. Zo wil je bijvoorbeeld dat elke pagina een 
paginanummer heeft of een bepaalde achtergrond. 
Noem het maar op.

Je kunt je Mastersheets vinden bij je “pagina’s” menu. 
Je kunt een nieuwe aanmaken door op de bovenste helft 
van het schermpje te klikken met je rechtermuisknop, 
en te klikken op “new master”.

We gaan nu een mastersheet aanmaken met allerlei 
hulplijnen en inderdaad dus een paginanummer. 
Let op: op de volgende pagina staan mijn instellingen.
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Hieronder staat weergegeven hoe je 
een hulplijn aanmaakt. Je sleept als het 
ware vanaf de lineaal aan de zijkant een 
lijn naar midden op je blad. Vervolgens 
kun je in je werk allerlei vakken precies 
hier op uitlijnen, zodat je design lekker 
mooi en consistent is.

Dan volgt hier nog een kleinigheidje: 
er  zijn twee soorten hulplijnen. Er zijn 
hulplijnen die alleen op 1 pagina zitten 
en echt tot de rand gaan, en er zijn 
lijnen die over de rand gaan en ook 
over de andere pagina heen. Het is aan 
jezelf om te kiezen welke je wilt, ik doe 
meestal maar dat tweede. 

Tijdens het maken van je lijn moet je wel goed letten op waar je je muis hebt tijdens het loslaten 
van de lijn: als je hem op het blad hebt,  dan zul je zien dat de lijn alleen op dat blad staat. Als je 
hem er net buiten hebt, zul je zien dat de lijn er dus overheen steekt. Zie onderstaand plaatje voor 
een voorbeeld. 

Maak dit raster hier rechts van deze tekst maar 
eens na.

Nu we dit raster hebben gebouwd, kunnen we dit 
toe gaan passen op onze pagina’s. Dan kunnen 
je vervolgens, als je daar zin in hebt, lekker alles 
mooi uitlijnen op deze hulplijnen. 

Een intermezzo
Tijdens de Workshop was er nog wat onduidelijkheid over wat nou precies een mastersheet is, 
en hoe je het effectief gebruikt. Daarom heb ik er even 2 extra pagina’s bij gepropt met uitleg en 
voorbeelden, om het jullie maar wat makkelijker te maken.

Een mastersheet is als het ware een soort blauwdruk die je toe kan passen op een daadwerkelijke 
pagina. Zo kan je makkelijk kopietjes maken van iets wat je altijd hetzelfde wilt hebben, en het 
telkens toepassen op je boekwerk. Zie het een beetje als een bouwplan voor een rijtjeshuis: elk 
huis is hetzelfde van structuur, maar de inrichting is afhankelijk van de persoon. 

Je wilt je mastersheet dus zo algemeen mogelijk maken, zodat je hem zo vaak mogelijk kan 
toepassen. Dingen die typisch op een mastersheet staan zijn dan bijvoorbeeld ook:
•	 Paginanummers
•	 Hulplijnen
•	 Achtergronden
•	 Kaders

Je kan oneindig veel mastersheets aanmaken. Realiseer wel dat als je een Mastersheet maakt die 
je maar 1 keer toepast, dat dat dus eigenlijk helemaal niet nodig is: je kan dat ontwerp net zo goed 
op die pagina zelf maken. Mastersheets zijn er immers puur om “massa-productie” makkelijker te 
maken. 

Een mastersheet is daadwerkelijk ook een sheet, met een linker en rechterpagina. Je kan de 
linkerpagina van je mastersheet ook alleen maar toepassen op linker pagina’s, en de rechter alleen 
maar op rechter pagina’s. Als je je paginanummer alleen op de linkerhelft van je mastersheet type 
A knalt, dan zullen de rechterpagina’s in je document van type A geen paginanummers bevatten.

Daarnaast werken mastersheets net als character styles hiërarchisch. Later in dit werkboek staat 
het ook al uitgelegd, maar om het op een andere manier te benaderen: als een sheet B alle 
elementen en eigenschappen van sheet A overerft, dan bouw je in sheet B dus eigenlijk een 
specifiekere variant van sheet A. Zo kan je in sheet A bijvoorbeeld alleen je paginanummers 
en achtergrond verwerken, en kan je vervolgens 5 verschillende mastersheets bouwen die alle 
eigenschappen van A overerven. 

Zo wil je bijvoorbeeld dat alle pagina’s met een interview er op een andere opmaak hebben dan 
de pagina’s uit je puzzelkatern, maar ze hebben het liefst wel allemaal de paginanummers op 
dezelfde plek. Als je dit zou willen doen, zou je dus met overerving werken.

Daarnaast kan je bijvoorbeeld ook weer een mastersheet maken die alle eigenschappen van B 
overerft: en daarmee ook alles van A, indien B dus gebaseerd was op A. Zo worden je mastersheets 
steeds specifieker en bespaar je jezelf een hele boel dubbel werk. Het loont, zoals je misschien 
wel merkt, dus echt als je je mastersheets al uitplant voor je je uiteindelijke document begint. 

Zo zijn het schrijven van je inhoud en het ontwerpen van je document dus echt twee aparte 
processen. Verreweg de meeste commissies die ik met InDesign aan het werk heb zien gaan 
doen het als volgt:

1.	 Mensen schrijven wat tekst in een programma naar keuze
2.	 Dat wordt nagekeken
3.	 Een andere groep mensen plakt het in de door hun ontworpen mastersheets
4.	 Dat wordt weer nagekeken
5.	 Klaar!
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Hieronder staat uitgebeeld hoe je je mastersheet toepast op ons prachtige document. Je selecteert 
een blad van je sheet, en vervolgens sleep je hem op je pagina zoals hieronder aangegeven. Als 
het goed is komt er ook op je pagina een B’tje te staan: dan weet je dat deze mastersheet van het 
type B is. (Dit kan je zelf nog aanpassen, maar ik vind het wel prima zo).

Dit werkt dus niet alleen met lijnen, maar ook met tekst 
of afbeeldingen. Zo kan je, zoals net ook uitgelegd, een 
tekstvak maken met een variabele erin. Als je hier nou je 
paginanummer in zet, zul je zien dat het prima uitpakt. 

Ga eens terug naar pagina 2 en 3. Dat zijn een paar mooie paginanummers die we daar hebben, 
al zeg ik het zelf. Je kunt ze dus expres niet meer aanpassen van bijvoorbeeld plek of lettertype 
op de pagina’s zelf, je moet dan weer echt terug naar de mastersheets. 

Hierboven zie je de mastersheet waarop mijn almanac commissie vorig jaar de almanac op heeft 
gebaseerd. We begonnen met het tekenen van alle hulplijnen: zo zie je bijvoorbeeld dat we onze 
tekst altijd in 1 of twee kolommen wilden hebben. We hebben daarnaast ook nog de hulplijnen per 
‘categorie’ een andere kleur gegeven, om zo iets duidelijker te maken wat nou wat was. Ik noem 
deze even mastersheet A1.

Vervolgens hebben we per hoofdstuk een andere achtergrond gebruikt: voor elk hoofdstuk hadden 
we dus een andere mastersheet nodig. 
Ook maakten we onderscheid tussen de volgende twee situaties:
1.	 Links en rechts behoren tot hetzelfde hoofdstuk
2.	 Links behoort tot een ander hoofdstuk als rechts

In het geval van situatie 1 hadden we nog een andere mastersheet B1, gebaseerd op A1. Hier liep 
de titelbalk bijvoorbeeld iets verder door, en hadden twee pagina’s echt een verband.
In situatie 2 hadden we een mastersheet B2, ook gebaseerd op A1. Hier liep het niet door, en 
hadden we twee aparte titelbalken. 
Vervolgens heeft elk hoofdstuk een eigen masterpagina met eigen achtergrond etc., en was er 
een exemplaar voor zowel situatie 1 als 2. 

Ik hoop dat het idee en daarmee ook het belang van mastersheets voor je document wat duidelijker 
is geworden. Een mastersheet is echt een soort ruggengraat van je bestand, dus schroom niet om 
er wat extra tijd in te stoppen: het zou heel zuur zijn als je op het einde de boel moet omgooien, 
en dan op al je daadwerkelijke pagina’s de inhoud weer moet aanpassen naar je nieuwe ontwerp. 
Vervolgens kan je ook in elke nieuwe editie van bijvoorbeeld je verenigingsblad dezelfde sheets 
gebruiken. Vet chill! 		

Dat was mijn intermezzo, succes met de rest van de workshop.
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Stel je nou eens voor dat je een almanak aan het maken bent, en je per hoofdstuk een andere 
achtergrond wilt, maar wel overal de paginanummers op dezelfde plek. Dat kan ook! Je kan een 
nieuwe mastersheet aanmaken, en vervolgens deze ‘baseren op’ de B-master.

Het werkt net zoals met tekststijlen maar een beetje anders: je zult in dit geval altijd de spullen 
zichtbaar hebben die ook op je B-master staan, maar je kunt er elementen aan toevoegen. Je 
kunt de elementen dan niet makkelijk meer veranderen op je pagina’s zelf. (Dat leer je in deel B)

Ik heb deze geestige achtergrond gekozen, en als afbeelding ingevoegd op de C-master. Echter 
is hij wel heel donker, en dat is met zwarte tekst wat lastig te lezen. Om dit te verhelpen kun je 
weer naar effecten gaan, en bij de opacity van het object de boel even dimmen. 

Je zult zien dat ook het paginanummer van je B-master opeens tevoorschijn piept. Hoe dit komt, 
leg ik straks uit.
Doe dit ook even op de andere kant, en pas vervolgens de C-master toe op je pagina’s. Je zult 
zien dat je overal opeens deze leuke achtergrond hebt.

Dat waren de basisprincipes van mastersheets wel. Mastersheets zijn vooral erg handig bij 
het maken van grote documenten zoals dus tijdschriften of jaarboeken, waarbij je de opmaak 
consistent wilt houden en overal hetzelfde wilt uitlijnen. Voor het jaarboek wat ik afgelopen jaar 
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heb gemaakt heb ik voor de 168 pagina’s die het besloeg ook rustig 30 mastersheets gebruikt. 
Het scheelt een hele boel werk!
Over werk schelen gesproken, er is nog een leuke eigenschap van InDesign die ik wil laten zien. 
Deze is erg handig als je met meerdere kolommen gaat werken en deze even groot wilt houden. 
Ik laat de afbeeldingen voor zich spreken, maar het is zeker de moeite om te onthouden.

Lagen
Net hadden we dus het probleem dat we de 
paginanummers niet meer zagen omdat de 
achtergrond er overheen zat. Dit komt omdat 
de achtergrond op een hogere laag zat. Zoals 
je misschien nog wel van de intro weet, is dat 
als iets op een hogere laag zit, je alles eronder 
niet meer kan zien. We hebben het toen even 
heel simpel opgelost met de doorzichtigheid 
aan passen van de achtergrond, maar dit is 
eigenlijk een vrij trieste oplossing.

Echte stoere mensen, zoals jij straks, zouden 
namelijk met lagen werken. Ga maar eens 
terug naar je B-master en klik op lagen. 
Maak vervolgens een nieuwe laag aan door 
op het ‘nieuw’ knopje te drukken (omcirkeld 
en gemarkeerd met een ‘1’ op onderstaande 
afbeelding). Je ziet dat er een nieuwe laag is 
bijgekomen, met standaard naam “Layer 2”. 
Sleep vervolgens de 2 text frames allebei even 

naar laag 2. 
Als je nu teruggaat naar je C-master, zie je dat deze lagen er nog steeds zijn. De achtergronden 
die we toen hadden ingevoegd zitten nog steeds op laag 1, en de tekst zit nu op een hogere laag, 
laag 2. Zelfs als je de doorzichtigheid van de afbeeldingen weer terugknalt naar 100%, zie je dat 
de nummers blijven staan. Vet handig!

Lagen werken namelijk als volgt: je hebt in je hele InDesign bestand als het dezelfde globale 
lagen, in dit geval “Layer 1” en “Layer 2”. Echter hebben deze lagen afhankelijk van op welke 
pagina je werkt, een andere inhoud. Zo kan je makkelijk per pagina het overzicht behouden. 
Binnen zo’n laag werkt de zichtbaarheids hiërarchie weer; de bovenste zie je eerst, etc. Als je op 
Mastersheet C je layer 2 vult, en vervolgens je hele Mark Rutte collectie uitstalt op layer 1, dan 
zul je zien dat alles van je mastersheet boven je plaatjes valt. 
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Om nog iets meer in detail te treden: onze fotopagina heeft de volgende lagen: 
We zien dat bijvoorbeeld het Radboud Universiteit-logo boven onze vervelende Minions valt. 
Als we nou het logo onder de minions zetten, dan zul je zien dat niet alles meer zichtbaar is: de 

minions vallen er boven. Er zijn nog wat andere interessante 
knoppen in je lagen-menu. 
Mocht je nou de hele tijd perongeluk je achtergrond verslepen 
en je wil die gewoon op slot zetten (= niet meer kunnen 
bewerken totdat je hem van het slot afhaalt) dan kun je dat 
zoals links aangegeven doen.

Selecteer de mastersheet weer. Als je klikt op de lege ruimte 
waar de slotjes bij mij staan, dan komen die vanzelf tevoorschijn. 
Vervolgens kun je die elementen niet meer bewerken. Handig 
voor bijvoorbeeld achtergrond-elementen.

Daarnaast is er ook nog een knop voor ‘zichtbaarheid’. Mocht 
je iets tijdelijk even niet meer willen zien maar niet permanent 
willen verwijderen, kun je op het oogje wat naast het slotje zit 
klikken, daarmee kan je de zichtbaarheid aan of uit zetten.

Beide bewerkingen kunnen zowel op individuele elementen als 
op de layer waar ze bij horen. Als je bijvoorbeeld op het oogje 

klikt bij Layer 1, zie je dat alle elementen uit Layer 1 even verdwijnen.
Zo zie je ook dat onze mooie collage dus weg is, dat komt omdat deze ook op Layer 1 stond. Het 
loont dus erg om tijdens je werk met veel lagen te werken, en deze allemaal zinnige namen te 
geven. Het kan nooit te ver gaan: je kan zo bijvoorbeeld ook een “Afbeeldingen” of “Teksten” laag 

maken.
Ik heb in mijn voorbeeld document bijvoorbeeld een paar aanpassingen gedaan aan wat we eerst 
hadden: ik heb een laag met de naam paginanummers, inhoud en achtergrond. Als je vervolgens 
de hele laag onzichtbaar maakt, zul je zien dat alle spullen die op die laag stonden opeens 
verdwijnen. (Zie volgende pagina)
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Kleuren en vormen
We zijn er bijna, maar nog niet helemaal. Voor ik jullie opzadel met een toffe opdracht, krijgen jullie 
van mij nog wat beloofde informatie over kleuren en vormen. 

Altijd maar gebruik maken van zwarte tekst is zo saai: wat nou als het in een andere kleur kon? 
Nou, verrassing: dat kan. In InDesign kun je meestal op twee plekken kleuren toepassen: op het 
object zelf, of een randje om het object heen. Zo kan je bij tekst zowel de kleur aanpassen, als 
een keurig tevens kleurig randje eromheen maken. Dat doe je als volgt.

Tijdens het bewerken van je tekst kan je op de 
twee knopjes klikken zoals hier links omcirkeld.

De bovenste gaat altijd om de kleur van de 
inhoud van het object. De onderste om de 
onlijning. Zo hebben we hier te maken met een 
zuivere combinatie van blauwe tekst, met een 
uitermate goed gekozen rood randje. 

De kleur kan je ook vastzetten in je character 
style.

Laten we het dan nu gaan hebben over vormen. In InDesign 
zijn de volgende standaardvormen beschikbaar: rechthoeken, 
ellipsen en veelhoeken (ja, dat is een woord). Je kan de meest 
geschikte voor jou uitkiezen door op rechtermuisknop te klikken 
bij het vorm-icoontje, dan krijg je precies te zien wat ik hier laat 
zien.

Daarna kan je net zoals met een tekstvak weer lekker gaan 
slepen en trekken met je vorm. Vermoedelijk heeft je vorm 
standaard geen kleur opvulling, en een zwarte rand. Dit kan 
je aanpassen op de plek waar je het zojuist hebt geleerd: 
bovenaan je scherm in die balk.

Het leven zou zo saai zijn zonder kleur, maar zelfs met de 
standaard kleurtjes van InDesign zou je het waarschijnlijk niet 
volhouden. Daarom mag je ook zelf je eigen kleuren invoegen! 
Deze staan dan altijd bij je pallet, dan kan je ze makkelijk nog 
een keer gebruiken. Een kleur toevoegen doe je zoals hier 
op het plaatje hier links van deze tekst aangegeven. Als het 

goed is verschijnt er een kopie 
van het palletkleurtje wat er is 
geselecteerd. 
Vervolgens mag je van mij even  
dubbelklikken op het icoon 
wat er helemaal rechts staat 
(omcirkeld in rood bij mij). Dan 
open je een nieuw menuutje.
Dan zul je zien dat je lekker 
creatief de kleur aan kan 
passen. Ook kan je de 

kleurmodus aanpassen. Deze is in InDesign altijd van het type CMYK, de “je van het” in de 
printerwereld als het gaat om het omschrijven van kleuren. Echter kan je als je het fijner vindt om 
met RGB te werken ook kleuren daarin maken. Echter adviseer ik wel heel erg om altijd in CMYK 
te blijven werken: als je je RGB kleur hebt geselecteerd kan je altijd nog teruggaan naar CMYK, 
en dan behoud je (ongeveer) je kleur. 
Het is erg zonde als je ruzie krijgt met je drukker in verband met dit soort kleur-problemen. Ook 
is CMYK de kleurmodus die de skuario printers op de RU hanteren: als je in RGB werkt zal je 
geprinte resultaat er soms nog anders uit zien.  Kortgezegd: werk altijd in CMYK. Daarnaast nog 
een leuk feitje: een vorm is eigenlijk gewoon een kader net zoals een tekstvak, dus je kan er ook 
in typen.

Eindopdracht
Dat was de basis al! Dat ging best prima, toch? Je kunt nu eigenlijk al veel meer dan je denkt. Om 
je vaardigheden tot nu toe nog even op de proef te stellen krijg je van mij nog een laatste vrije 
opdracht, om het A-gedeelte af te sluiten. Het is nu aan jou om je eigen CV te ontwerpen! Zo maak 
je gelijk de blits bij je nieuwe werkgever, en heb je een kleine voorsprong op je andere kandidaten. 
Ik heb hieronder ter inspiratie wat voorbeelden ingevoegd (niet mijn spul), maar wees vooral vrij 
om hem zo te ontwerpen en in te delen zoals jij wilt. Je hoeft je CV, zoals je net hebt geleerd, nog 
niet van daadwerkelijke inhoud te voorzien: het gaat nu even puur om het ontwerp.
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Veel blauw, lekker overzichtelijk. Let goed op de details op de achtergrond en het gebruk van 
verschillende lettertype(-stijlen). Ook legt onze vriendin Desiree veel nadruk op bepaalde 
elementen door middel van de blauwe blokken links.

Onze vriendin Tanya heeft het nog niet helemaal begrepen: onderaan bij de hobbies steken er 
een paar icoontjes uit. Dat kan jij beter, ook al zegt zij een van de beteren te zijn in InDesign. Wat 
een koekenbakker.
Wat ze dan wel weer aardig doet is hoe ze het document opsplitst in secties.
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Daarna hebben we nog Jane. Jane weet wel hoe je kleuren effectief kan gebruiken, en hoe je 
daarmee de lezer meteen kan ‘sturen’ naar volgens haar de meest belangrijke elementen. Wat ik 
dan wel weer een beetje treurig vindt, is hoe “Emotional Intelligence” (skills, links) wordt afgeknipt. 
Dat kan jij ook beter!

Als laatste hebben we meneer John. John heeft het zo te zien niet zo op afbeeldingskwaliteit, maar 
dat zal voor jou denk ik ook geen probleem zijn. John maakt ook goed gebruik van verschillende 
lettertype-stijlen om nadruk te leggen op bepaalde elementen. Ook deelt hij het document slim in 
twee delen op met een paarse rand.
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Na het afkraken van wat CV ontwerpen hier en daar, is het dan eindelijk tijd voor wat serieuzere 
zaken. Je schaart je nu onder de elite van de InDesigners op de RU, welkom bij de club. 

Zoals beloofd gaan we het hier hebben over
•	 Geavanceerdere tekst opties
•	 Groepen
•	 Meer over Mastersheets
•	 Interactieve PDF’s
•	 Adobe Integratie
•	 Exporteren, printen, etc. voor gevorderden

Ik ga er van uit dat jullie al het een en ander onder de knie hebben en weten hoe alle voorgaande 
thema’s in elkaar zitten, dus ik zal ook iets minder schermafbeeldingen in dit gedeelte plaatsen. 
Als iets niet duidelijk is weet je wat je moet doen: je hand opsteken als je nog bij de workshop bent 
of even Google raadplegen.

Geavanceerdere tekstopties
Tekstvakken zouden geen mysterie moeten zijn, maar er zijn nog allemaal speciale opties 
verborgen in InDesign die je wellicht over het hoofd zou zien.

Omloop
Je weet nu hoe je tekst om een vierkant kader heen kan laten lopen, maar soms is het interessanter 
om het om het exacte object heen te laten gaan. Ik heb voor mijn voorbeeld een cognac glas 
genomen, gewoon, zomaar... Zet je tekst en afbeelding neer zodat ze een beetje overlappen. 

Gedeelte B
Goed gewerkt! Hopelijk ben je nu de eigenaar van een CV waar je ‘U’ tegen zegt. Wat ik echter 
tot nu toe nog niet heb uitgelegd, is hoe je al dit moois nou exporteert. Stel je wil het trots aan je 
ouders of je toekomstige werkgever laten zien, dan zullen zij vermoedelijk niet erg tevreden zijn 
met een .indd bestand. 

Je hebt hopelijk ooit in je leven het concept .PDF al eens voorbij horen komen. Ik ga nu uitleggen 
hoe je je bestand opslaat als PDF! Dan kan je het ook super professioneel op WhatsApp versturen 
en openen, zonder dat er kwaliteit verloren gaat (dat is bij afbeeldingen vaak wel het geval). Wie 
wil dat nou niet.

Als je naar “File” -> “Export” gaat, of simpelweg eventjes “Control + E” induwt, mag je een 
bestandsnaam uitzoeken. Ik zou de bestandsoort lekker laten staan op “PDF print” voor nu. 
Daarna krijg je dit schermpje te zien:

Afronding A

Het is eigenlijk al bijna klaar nu. Je kan in principe gewoon op “Export” rammen en even later heb 
je op de reeds geselecteerde plek een prachtige PDF staan van je werk. Je kan, mocht je er trek 
in hebben, ook nog even van alles aanpassen aan hoe je bestand er uit ziet. Wellicht wil je niet 
alle pagina’s, maar maar een selectie ervan uitdraaien. 

Je kan ook de boel als “spread” in plaats van pagina uitprinten; dit zorgt er voor dat je pagina’s 
die links en rechts van elkaar staan (zoals onze mooie collage) als 1 opslaat, in plaats van 
los. Hierdoor voelt het al sneller als echt boekje en zie je beter hoe het er uit gaat zien, ook in 
verhouding tot elkaar. Neus vooral even rond in het menuutje, maar schrik niet als je niet van alles 
weet wat er staat. Als je echt bij een professionele drukker gaat printen, krijg je wel een lijstje met 
aanleverings-eisen van je PDF bestand.

Dat was deel A! Ik hoop dat je er veel van hebt geleerd. Mocht je nog niet huilend naar huis zijn 
gegaan, mag je ook doorstomen naar deel B. Tot daar.

Jorrit
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Zorg overigens wel dat je afbeelding een doorzichtige achtergrond heeft: dit is typisch iets wat 
.PNG afbeeldingen hebben. Je kan tijdens het Googlen ook zoeken op “png”, of bij je kleuren 
“Transparant” aanklikken. Weer wat geleerd!

Goed, terug naar ons cognac glas. Als je gaat naar “Window” -> “Text wrap”, of “Control + alt + 
W”, dan krijg je een schermpje te zien. Als je op de afbeelding klikt, zul je zien dat de bovenste 
knoppen opeens aan te passen zijn. Klik vervolgens even op het middelste icoontje, het balletje 
wat midden in de tekst staat. De opties eronder zullen ook opeens weer aan te passen zijn.

Er zijn “Wrap options” en “Contour options”. Bij de wrap options kun je kiezen hoe de tekst om je 
afbeelding vouwt. Wil je dat de tekst er strict links of rechts van loopt, of juist aan beide kanten? 
Kies maar raak.
Bij contour options heb je te kiezen uit op hoe wordt bepaald hoe de tekst om de afbeelding heen 
vouwt. Wil je bijvoorbeeld dat het om het frame vouwt, of juist om de contouren van je afbeelding? 
Als je “Detect edges” selecteert, zal InDesign zelf de randen van je afbeelding bepalen. Dit gaat 
99% van de tijd gewoon goed, en je tekst zal keurig om je object lopen.

Daarnaast kan je ook nog de afstand tussen de tekst en je afbeelding bepalen: deze staat nu op 
0p, maar je kan even met de afstand spelen en kijken wat voor jou een prettige afstand is. Voor 
maximaal resultaat zorg je dat je tekst de hele regel beslaat, zoals eerder geleerd.

Referenties
Soms wil je binnen je tekst naar een pagina refereren waar volgens jou een relevant element 
staat, zoals bijvoorbeeld een grafiek of tabel. Het kan echter zijn dat je nog niet zeker weet op 
welke pagina dat stukje eindigt, omdat je nog een beetje aan het schuiven bent met je inhoud. 

Om alsnog naar de correcte pagina te refereren zonder je tekst telkens te hoeven aan passen, kan 
je weer gebruik maken van zo’n tekstvariabele. Nu wil je echter niet je paginanummer invoegen, 
maar het paginanummer van het relevante element. Om dit uit te beelden heb ik even onze 
vervelende gele makkers erbij gehaald, de minions.

Als je wilt dat op de ‘...‘ het juiste paginanummer komt te staan, moet je zoals in het plaatje links-
onder aangegeven klikken op “insert Cross-Reference”, en vervolgens kan je een paragraaf/
tekststuk selecteren om naar te refereren. Klik maar eens op “OK” en zie maar wat er gebeurt.
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Dat is wel een beetje stroef, zeg. InDesign plakt er gewoon zomaar een hele zin in, in plaats van 
louter het paginanummer. Dat gaan we even verhelpen. Ga maar weer terug naar “Insert Cross-
Reference”, en doe dit even na:

Zoals je kan zien stond het “Format” nog op “Full paragraph & Page Number”. Dat is wel een 
beetje overdreven. Er zijn nog veel meer opties, maar zelfs de “Page Number” optie is het niet 
helemaal: er staat namelijk “Page #”, en wij hebben nu even geen behoefte om “Page” midden in 
onze zin te zetten.

Pas daarom rechts even bij de “definition” de zin aan zodat hij naar jouw wens is! Je kan ook even 
rondneuzen naar wat er dus allemaal mogelijk is, mocht je dit ooit voor iets andere doeleinden 
gebruiken. Vergeet na je speurtocht in dit menuutje niet op Save te klikken en hem vervolgens toe 
te passen! Als het goed is ziet je tekstje er dan zo uit:

Waar je minionplaatje dan ook heen mag gaan, het paginanummer zal altijd mee veranderen. Let 
wel, de referentie is dus naar het onderschrift en niet naar het plaatje. Er is wellicht wel een optie 
om naar een plaatje te refereren, maar daar weet ik ook niet van.. daar heb je me. Hopelijk kun je 
het vinden op Google als je het echt nodig hebt!

Tabellen
Tabellen maken is ook mogelijk in InDesign! Het is eigenlijk een best wel simpel trucje, je gaat 
naar “Table” -> “Insert Table” of drukt op “Control + Alt + Shift + T”. Vervolgens kan je o.a. het 
aantal kolommen en rijen selecteren. Als je daarna op “OK” hebt geklikt, wordt er van je verwacht 
om weer een vierkant te tekenen waar de tabel in valt. Maak maar een tabel van 7 bij 7. We gaan 
nu even onderstaande tabel namaken, met kleuren en al.

Je ziet hierboven een paar dingen terugkomen: andere celhoogtes, cellen die samen zijn gevoegd, 
kleuren van hokjes en zelfs gedraaide tekst. Er zijn nog veel andere dingen mogelijk, maar als je 
de bovenstaande dingen kunt, weet je ook waar je de rest ongeveer moet zoeken.

Laten we maar beginnen met de celhoogtes. Als je je text tool selecteert en over je tabel zweeft 
met je muis, zie je dat je of kan typen in het vakje, of een lijntje kan verslepen. Als je dit doet, zul 
je merken dat de andere kolommen meeschuiven zodat ze even breed blijven. Mocht je alleen de 
lijn willen verplaatsen en de rest intact willen houden, kun je de lijn verschuiven met je shift-toets 
ingedrukt. 

Als je aan het selecteren bent in een tabel moet je rekening houden met dat je ofwel de inhoud 
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van slechts 1 cel aan het selecteren bent, ofwel de cel in het algemeen, ongeacht de inhoud. Dat 
eerste is handig als je bijvoorbeeld de character style wilt aanpassen van je hele cel, maar dat 
tweede is handig als je bijvoorbeeld je hokje een kleur wilt geven. Selecteer maar eens een paar 
hokjes, en geef ze een kleur op de manier zoals je dat geleerd hebt.

Daarnaast kan je, als je meerdere hokjes geselecteerd hebt, op rechtermuisknop klikken en 
“Merge Cells” selecteren. Dit zorgt ervoor dat je ze samenvoegt, zoals ik bovenaan en rechts 
gedaan heb. Vervolgens heb ik tijdens het selecteren van de bovenste 2 rijen aan hokjes ook nog 
even op “tekst centeren”  geklikt, waardoor het midden van de tekst dus in het midden van het 
hokje valt. Op pagina 14 staat hoe dat moet, als je het al weer vergeten bent.

Als laatste hebben we dan nog de gedraaide tekst. Typ maar eens wat in hokje, en selecteer 
daarna het hele hokje, als hokje en niet de tekst dus. Vervolgens kun je bovenaan je tekstrichting 
selecteren.
Daarnaast, mocht je later ooit nog de 
instellingen van je tabel willen wijzigen, dan 
kun je het volgende doen:

1.	 Selecteer een hokje als hokje
2.	 Klik op rechtermuisknop op het hokje
3.	 Selecteer “Table options” -> “Table Setup”. 

Als dat niks voor jou is kan je het ook het aantal rijen en kolommen sneller aanpassen. Even 
rechts van de tekstdraaiknop zit namelijk ook een knop om het aantal rijen en kolommen aan te 
passen. Zorg wel dat ze in het kader van je tabel passen, anders krijg je weer zo’n rood plusje  
onderaan je kader omdat niet alles er in past.

Groepen
We hebben tot nu toe best vaak gehad dat je twee elementen altijd bij elkaar wilt houden als 
combinatie, bijvoorbeeld een afbeelding met een onderschrift. Je wilt eigenlijk altijd als je de 
afbeelding verplaatst, dat je ook het onderschrift mee verplaatst en andersom. Daarnaast wil je 
wellicht ook vast wel zo nu en dan precies dezelfde opmaak gebruiken voor je vaste “afbeelding 
+ onderschrift” combinatie. Dit probleem schreeuwt om een oplossing, en die is er: groepen.

Natuurlijk is dit niet alleen toepasselijk op afbeeldingen en onderschriften, maar op letterlijk 
elke combinatie van elementen. Als je nou eenmaal de perfecte verhouding hebt gevonden 
voor elementen kan je ze ‘vriendjes’ maken: als de ene gaat gaat de ander ook. Dit doe je door 
objecten te selecteren en te klikken op “Group” in het menuutje dat tevoorschijn komt als je er 
met rechtermuisknop op klikt, of door te duwen op “Control + G”. Vervolgens zie je dat er een 
gestippelde rand ontstaat om je objecten. 

Je hebt nu als het ware een nieuw kader aangemaakt waarin je niet 1 object bewaart, maar 
meerdere. Je kan vervolgens dit kader gewoon verslepen en je zult zien dat alles keurig in dezelfde 
verhouding van elkaar meebeweegt. Geen zorgen, je kunt de elementen gewoon nog aanpassen: 
dubbelklik maar even op je gewenste element en dan kan je er weer lekker mee doen wat je altijd 
gewend was.

Als je je ooit nog bedenkt op het groupen, kun je de elementen ook weer ‘ungroupen’ door op 
“Ungroup” te klikken, of “Control + Shift + G”.

Groepen zijn op heel veel dingen van toepassing, en je vindt er vast wel een leuke plek voor. Het 
is echt een wondermiddel om alles lekker consistent te houden, en daar houden we van.

Meer over Mastersheets
Er zijn nog een paar dingen over Mastersheets die ik net nog niet heb verteld, gewoon om het nog 
even simpel te houden. Maar nu je groot en sterk bent, heb je het recht om de donkere zijde van 
onze betrouwbare vrienden te zien. Ofzo. Ik vond het wel cool klinken.

Overlappende elementen
Je hebt misschien al wel een keer gehad dat je een mastersheet hebt gehad en die hebt toegepast 
op de linkerpagina, en dat de elementen ook verschijnen op de rechterpagina, terwijl die een 
andere mastersheet heeft. Mocht je dat niet hebben, gaat het je waarschijnlijk wel overkomen. 
Maar na deze lap tekst weet je in ieder geval wel hoe dat komt, en wat je er aan kan doen.
Zelf bij het maken van deze workshop-boekje had ik dat probleem. Als ik aan een kant een schuin 
wit balkje wilde hebben om een titel in te plaatsen, dan komt hij ook automatisch aan de andere 
kant, terwijl dat niet helemaal mijn bedoeling was.

Mijn mastersheet ziet er als volgt uit:

Zoals je kan zien gaat de balk links over de paginarand heen, zodat hij zowel de linker als de 
rechterpagina beslaat. Nu komt het grapje: zodra InDesign merkt dat een element een stukje mist 
(omdat het dus op een andere pagina staat) laadt InDesign de hele andere pagina ook meteen 
voor je in, terwijl we alleen een hip balkje wilden die over de pagina uitsteekt. Ik heb nog steeds 
geen goede manier gevonden om hier mee te dealen, dus ik doe het maar op een droevige 
alternatieve manier:
1.	 Ik zorg gewoon niet dat een element over de pagina uitsteekt
2.	 Of; als ik het echt nodig heb, dan knip ik het element op in 2 delen, elk pagina zijn eigen deel. 

In dit geval zou ik dan de linkerhelft die op de andere pagina valt los opslaan en er dan links 
bij plakken als ik alleen de rechterkant gebruik. Het is een zeer primitieve oplossing en er moet 
vast iets beters zijn: maar zo zie je maar, soms moet je roeien met de riemen die je hebt.
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Nu heb ik nog wel een leuk trucje. Mocht je nou echt vrij willen breken uit je mastersheet voor  
slechts een enkele pagina, dan kan dat ook. Je kan immers op een pagina je mastersheet 
elementen verslepen met de selection tool als je “Shift + Conrol” ingedrukt houdt (en de elementen 
niet gelocked staan met het slotje op het lagenscherm). 
Wat ontwerp advies: het kan heel mooi zijn om dit voor echt belangrijke elementen te doen die echt 
aandacht nodig hebben van de lezer, maar doe het vooral niet te vaak om je bestand congruent 
en consistent te maken.

Je kan ook op je mastersheet werken met “Frames”. Dat zijn als het ware de kaders die we 
telkens hebben gebruikt, maar dan zonder inhoud. Je kan dan op de pagina zelf heel gemakkelijk 
een nieuw tekstvak aanmaken en die eroverheen plakken. Ook kan je, in plaats van een nieuw 
vak eroverheen te mikken, het vak op deze pagina specifiek aanpassen door het “Shift + Control”  
trucje van de vorige alinea. Handig!

Een laatste tip voor het maken van grote bestanden: werk eerst je mastersheets nauwkeurig uit 
en maak wat voorbeeld pagina’s met willekeurige foto’s en tekst om een beeld te krijgen van hoe 
je pagina’s er uit gaan zien. Als je zorgt dat je mastersheets helemaal in orde zijn voordat je je 
document in elkaar gaat zetten, bespaar je jezelf een hele boel tijd.

Basis Interactieve PDF’s
Zoals net uitgelegd, zijn PDF’s eigenlijk de beste manier om je InDesign bestanden aanschouwbaar 
te maken voor de niet-InDesign-gebruikende medemens. Als je je bestanden louter maakt voor 
digitaal gebruik, en ze dus niet print, dan kan je nog gebruik maken van een handige feature om 
je bestanden wat meer leven te geven.

We hebben net geleerd hoe je een tekst-referentie maakt. Maar goed, dan lees je op welke 
pagina het minion plaatje staat. En dan wat? Dan moet je er helemaal heen scrollen. Wat nou als 
je op dat nummer kan klikken, en dat je automatisch naar die pagina wordt gestuurd?

Om dat te doen, moet je werken met text anchors. Dat zijn, zoals de naam al suggereert, ankers 
in je tekst waar je terug naar wilt verwijzen. Die moet je speciaal aanmaken, en dat is nog wel 
even puzzelen.

Open “Window” -> “Intractive” -> “Hyperlinks”. Vervolgens krijg je een vrij leeg en nietszeggend 
schermpje voor je neus. Voor ik over dit schermpje ga vertellen, wil ik nog een leuk trucje meegeven: 
je kan een schermpje dat je vaak gebruikt opslaan in je vaste windows, onder bijvoorbeeld je 
pages, layers en links. Als je de bovenste rand ernaartoe sleept zoals hieronder aangegeven.

Ohja. Dat schermpje dus. Als je nou klikt op dat knopje wat ik net heb omcirkeld, dan zie je de 
optie staan “New Hyperlink Destination”. Dit is hoe je een text anchor aanmaakt. Selecteer het 
stukje tekst waar je naar wilt verwijzen, klik dan daadwerkelijk op deze knop, zorg dat je “text 
anchor” geselecteerd hebt en je anker een zinnige naam geeft, en klaar is kees. Je hebt nu je 
‘doelwit’ van je hyperlink gemarkeerd.

Vervolgens kan je nu vanuit allerlei andere plekken in je bestand een verwijzing maken naar die 
plek toe. Als je nu in je hyperlinks schermpje onderaan klikt op het “New Hyperlink” icoontje terwijl 
je de tekst hebt geselecteerd die je als “link” wil gebruiken, dan kan je ervoor zorgen dat je tekst 
linkt naar de “text anchor” die je net hebt aangemaakt. Als het goed is krijgt je link-tekst dan ook 
automatisch een hyperlink character style die je nog helemaal kan aanpassen.

Als je je document nu zou exporteren naar PDF, kan je op je link-tekst klikken en dan kom je 
automatisch terecht op de pagina van je “text anchor” vet chill.

Dit is de basis van interactieve PDF’s, zoals je hebt gezien zitten er in “Window” -> “Interactive” 
nog heel veel specifieke andere dingen zoals knoppen, tekstvelden die men in kan vullen, noem 
het maar op. Het is zeker de moeite om er naar te kijken, maar ik heb het nog nooit gebruikt dus 
ben vermoedelijk ook niet de beste persoon die het je kan uitleggen.

Adobe Integratie
Mocht je nou echt erg gesteld zijn op je dagelijkse Photoshop of Illustrator uurtjes en je bestanden 
willen verwerken in InDesign, dan zou je ze kunnen converteren naar een PDF of afbeelding en 
ze kunnen invoegen zoals we eerder hebben gezien. Echter, mocht je nou bijvoorbeeld weer een 
aanpassing willen maken aan je Photoshop bestand, dan is het erg vervelend om telkens weer 
alles los op te moeten slaan. Niet alleen kost dat veel tijd, het kost ook veel ruimte op je PC. 

Onze vrienden bij Adobe hebben hier ook al weer wat op bedacht: als je een bestand in je InDesign 
file mikt, kan je met rechtermuisknop klikken op “Edit original” of “Edit with...” en vervolgens je 
gebruikelijke Adobe software selecteren. 
Je kan ook bijvoorbeeld een .psd bestand invoegen, en die dan bewerken. Als je hem opnieuw 
opslaat zie je dat hij in InDesign meteen ververst! Bof jij even.

Exporteren, printen, etc. voor gevorderden
Eerder deze workshop heb je al geleerd hoe je documenten makkelijk exporteert. Echter zijn er zo 
veel opties, dat ik net zo goed even een sectie kan wijden aan hoe je een document goed begint 
en afrond.

Aantallen
Als je iets gaat printen, moet je aantal pagina’s altijd een veelvoud van vier zijn. Dat is omdat, stel 
jouw pagina formaat is A5, de drukker het op een A4 print. Vervolgens vouwen ze het dicht, en 
heb je dus voor en achter 2 pagina’s: 2 x 2 = 4. Het aantal velletjes maakt zorgt er dan voor dat 
het een veelvoud is van vier, dat is het ‘geheim’.

Afloop
Daarnaast willen professionele drukkers ook vaak dat je met “afloop” werkt. Afloop werkt als 
volgt: als je heel je printwerkje door het midden vouwt, zul je zien dat de binnenste blaadjes een 
beetje uitsteken. Je wilt wel dat je boekwerk een rechte rand heeft, anders ziet het er een beetje 
slordig uit. Daarom werken veel drukkers met afloop; ze printen eerst alles uit en snijden dan de 
boel recht aan de zijkanten. Dit doen ze echter niet ultra nauwkeurig, waardoor het soms nog een 
beetje kan schelen. Je moet daarom je pagina iets groter ontwerpen dan hij daadwerkelijk gaat 
worden, zodat er prima wat afgesneden kan worden zonder dat dat een probleem is. De extra 
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ruimte die je dan gaat gebruiken, is je “afloop”. Wacht, heel veel tekst. Even een plaatje.

Dit is hoe je InDesign document er uit zal zien met “Afloop” erbij. Je hebt de bekende paarse 
lijnen waar je belangrijke inhoud moet vallen, het witte wat je papier weergeeft en het rode randje 
eromheen, die dus nieuw is. Dit is je afloop. Deze staat nu, en meestal ook, op 3mm. Als je zorgt 
dat al je afbeeldingen niet op de rand van het witte eindigen maar op de rand van het rode, dan 
zal het geprinte resultaat er zoals links uitzien, en niet zoals rechts.

Je kan bleed instellen in je “File” -> “Document Setup”. Zorg dan dat al je inhoud tot aan het rode 
doorloopt, en al je werk zal er opeens een stuk professioneler uit zien.

Links
Daarmaast zou het chill zijn als al je plaatjes voldoende kwaliteit hebben: je wil niet honderden 
euro’s stoppen in een tijdschrift met alleen maar gepixeleerde plaatjes, dat is zonde. Een goed 
bestand gebruikt 300 “pixels per inch”, ofwel 300 ppi. Maar de kwaliteit is ook afhankelijk van hoe 
ver je je foto inzoomt. Je kan de beste foto nog steeds helemaal verpesten door hem 400 keer in 
te zoomen, en je kan de slechtste foto nog steeds publiceren als je hem maar niet te groot maakt. 
Waar we naar op zoek zijn, is iets wat ons zegt of de kwaliteit nou “goed genoeg” is.

Als je in je scherm helemaal rechts naar “Links” gaat, dat ene tabje naast “Pages” en “Layers” wat 
je de hele tijd hebt genegeerd, dan krijg je een lijst te zien van al je afbeeldingen. Vervolgens kun 
je op een specifieke afbeelding klikken (niet op het oranje paginanummer, dan ga je namelijk naar 
de desbetreffende pagina). Als je op bijvoorbeeld de titel klikt, krijg je onderin je schermpje een 
lange lijst aan getalletjes te zien. 

Waar je benieuwd naar bent, is de waarde die staad bij “Effective PPI”. Als deze waarde hoger dan 
150 is, krijg je hem bij de meeste drukkers er wel doorheen: dit is een gebruikelijke drempelwaarde 
voor je effective ppi.

Exporteren
Als je je werkje eindelijk wilt gaan exporteren, is het belangrijk dat je je afloop en dergelijke mee-
exporteert. Daarnaast willen sommige drukkers ook nog dat je de snij-randen mee exporteert. Ik 
ben de beroerdste niet: ik leg even uit hoe dat moet. Dat scheelt jou weer 3 uur aan zoeken (dit is 
een indirecte sneer naar mijn vorige drukker).

Zorg in het exporteer menuutje dat je de volgende dingen aan hebt gevinkt:

Je standard moet zijn PDF/X-3:2002. Dit is een beetje de Formule 1 onder de PDF’s, goed spul 
dus. De crop marks zorgen ervoor dat de drukker al meteen de snijranden heeft, en de bleed 
settings zorgen ervoor dat de bleed die je in je document gehanteerd hebt overal gebruikt wordt.

Ik zeg niet dat elke drukker dit zo van je moet krijgen, maar ik weet van een boel bedrijven wel dat 
dit hun standaard is, ook al zeggen ze dat er lang niet altijd bij. Als je van niets weet en je levert 
het zo aan, zit je waarschijnlijk goed. Dat scheelt je weer een paar dagen heen en weer mailen.

Eindopdracht
Zo zo, jij bent me er een. Je hebt het wel aardig onder de knie zo te zien! Om nou echt jezelf te 
bewijzen ga ik je nog één laatste opdracht meegeven. 
Maak een tijdschrift over een onderwerp naar keuze, met daarin de volgende elementen:
•	 Een moderne voorpagina;
•	 Een fotocollage;
•	 Een puzzelkatern;
•	 Een reclamepagina voor jouw studievereniging;
•	 Een interview met jouw favoriete artiest met speciale tekst-omloop
•	 Een recept van jouw favoriete gerecht;
•	 Een review van een evenement;
•	 Een colofon;

Het gaat dus weer niet om de daadwerkelijke inhoud, maar puur om het ontwerp. Kies je 
mastersheets op een slimme manier, bedenk interessante of creatieve manieren om je informatie 
weer te geven en maak er maar een mooi kunstwerk van. Hierna volgt weer wat inspiratie!
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Ik steel dit allemaal van Google trouwens, zoek er vooral meer op. Ik vind dit wel mooie voorbeelden 
omdat ze goed gebruik maken van kleuren, fonts en kaders!



46 47SOFv InDesign Workshop | Jorrit Geels SOFv InDesign Workshop | Jorrit Geels
Ruimte overlaten is ook mooi. Je hoeft niet alles op te vullen! (Zoek maar eens op Horror Vacui) Nouja, je komt er wel uit. Maak er wat moois van!
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Einde Workshop
Dat was het alweer. Zoals ik al eerder heb gezegd, mag je je nu tot de InDesign elite kronen van 
de RU. Je hebt nu alle trucjes in handen om de mooiste jaarboeken en brochures te maken, de 
enige limiet die er nu nog is is je eigen creativiteit. 

Zoals al eerder gezegd, mocht je iets niet weten, dan kan je het gewoon opzoeken: InDesign heeft 
een hele grote gebruikersgroep en een actief forum waar vragen op gesteld worden en daarna 
ook uitgebreid beantwoord. Daarnaast zijn er nog duizenden mensen zoals ik die het leuk vinden 
om de boel allemaal uit te leggen, dus schroom niet om nog een online workshop te volgen, of 
gewoon naar wat tutorials te kijken.

Je leert het nou eenmaal door er gewoon veel tijd in te stoppen! Je eerste ontwerp zal nooit het 
mooiste ontwerp zijn, je kan het altijd nog aanpassen. Open staan voor fouten en daar graag van 
willen leren is voor InDesignen het belangrijkste, maar in het leven ook wel. Nouja, veel dieper 
dan dit wordt mijn workshop tekst niet.

Ik heb het al te vaak gezegd, maar ik hoop oprecht dat je er van genoten hebt en veel geleerd 
hebt, dat heb ik namelijk ook! Ben jij straks dat ene figuur die al z’n presentaties en projecten in 
InDesign gaat maken? Of misschien wel te notulen van je commissie? Ik zou het niet doen, maar 
be my guest...

Om af te sluiten met een vrolijke noot, heb je hier een toepasselijke meme. Het is wel zo’n classic 
9GAG-format meme die ik normaal liever niet in mijn buurt zou laten komen, maar ik vond hem 
voor nu wel geestig. Ik zie het door de vingers.

Dag.

Jorrit


